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Cautions and Warnings

Laerdal SimBaby should be operated by trained persons. Treat 
SimBaby as you would treat a real patient. A general inspection 
should be conducted regularly. Do not use the product if cables or 
tubings have signs of damage.
Students should wash their hands prior to using the simulator and 
wear gloves. 
Use on clean surface only. Avoid felt tipped markers, ink pens, ace-
tone, iodine or other staining medications, and placing the manikin 
on newsprint or inked lines of any kind. Do not allow the manikin’s 
skin to come in direct contact with ink or photocopied paper,  
as this can permanently stain the skin. Mouth-to-mouth/nose/mask 
ventilation shall not be performed on SimBaby due to cleaning  
issues. Do not introduce any fluids into the torso area or left (BP) 
arm of the manikin, as electronic components can be damaged.  
Do not introduce any fluids (except airway lubricant in small 
amounts to lubricate the airway adjuncts) into the esophagus or 
trachea of the manikin. After each session involving airway lubricant 
the esophagus filter must be replaced. See “Maintenance”for more 
information. If a training session involves the administration of fluids 
and/or drugs into the IV arm and IO/IV legs, empty the arm and legs 
immediately following the training session.

Use of a defibrillator for training purposes represents an operational 
hazard equivalent to use of a defibrillator on a real patient since it 
involves the release of high levels of electrical energy into the trai-
ning manikin. 

Consequently:
All safety precautions for use of defibrillators must be followed, as if 
the manikin were a patient. Consult your defibrillator’s User Manual.
-	 Defibrillation should be performed on the defibrillation  
	 connectors only. If defibrillation is performed over one or more  
	 of the ECG connectors, high voltages may be present on the  
	 remaining connectors during the shock. Defibrillation attempts  
	 via the ECG connectors will also damage the internal electronics  
	 requiring that they have to be replaced.
-	 To prevent overheating, do not provide more than three (3)  
	 defibrillator discharges (max 360J) in a sequence. Do not exceed  
	 an average of two (2) defibrillator discharges per minute during  
	 the training session.
-	 The manikin must not be in contact with electrically conducting  
	 surfaces or objects during defibrillation. A flame-supporting  
	 atmosphere, for example with a high content of oxygen, should  
	 be avoided during defibrillation. 
-	 The manikin chest must be kept dry. Special attention should  
	 be taken when using IV Arm and IV/IO Leg.
-	 To prevent chest skin electrode pitting, do not apply conductive  
	 gel or conductive defibrillation pads intended for patient use.
-	 Do not use cables or connectors having visible damage. 
-	 Do not spill fluids over any component inside the manikin torso,  
	 since this could damage the unit and might also present a possible  
	 hazard for the operator.

This device generates uses and possibly radiates radio-frequency 
energy. If it is not installed and used in accordance with the instruc-
tions, it may cause harmful interference to radio  
communications. In that case the user is encouraged to attempt  
correction of the interference by:
-	 Reorienting or relocating the receiving antenna.
-	 Increasing the distance between the device and receiver.
-	 Connecting the device to an outlet on a circuit different from  
	 that to which the receiver is connected.
-	 Consulting the dealer or an experienced radio/TV technician  
	 for help.

Latex
The veins in the IV Arm and in the lower legs, and Pneumothorax 
bladder contain latex. Users who suffer from latex allergy should 
take precautions while using or handling the latex parts by wearing 
non-latex protective gloves.

	 Approvals:
	 The product is CE-marked and in compliance with 
	 essential requirements of council directive 89/336/EEC; 
	 EMC – directive.
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Introduction

SimBaby is a full-scale simulator with realistic anatomy and clinical 
functionality that enables simulation training. SimBaby includes softwa-
re with video debriefing and an interactive technologically advanced 
manikin allowing learners to practice the emergency  
treatment of patients.
SimBaby is a full body, 6 months old infant manikin that allows the 
simulation of a wide range of skills and assessment to develop both 
individual and team skills.

The simulator allows observation and recognition of most vital signs 
which are used in emergency medicine either directly on the manikin 
itself or on the included simulated Patient Monitor. When used  
correctly, these features will support the students’ competence  
ability to reach the correct diagnosis based on active observation  
as opposed to being prompted by instructor cues.

The patient monitor also doubles as display for other functions, such 
as display of 12-lead ECG and X-rays.

The manikin allows for most relevant medical intervention to be  
performed according to their medical guidelines and protocols.  
The Laerdal SimBaby contains an advanced airway allowing for simula-
tion of difficult airway management cases. The anatomy can be chan-
ged during the scenario to indicate changes to the patient condition 
or as a response to students’ intervention. Correct form and techni-
que are required to perform direct laryngoscopy and endotracheal 
intubation. Correct use of a variety of airway adjuncts will successfully 
ventilate the patient simulator. 

The simulated patient monitor is a replication of the Philips IntelliVue 
patient monitor, which includes the ability to set up the screen layout 
in various ways. It also allows configuration outside the IntelliVue’s 
features to mimic other patient monitor types as well.

SimBaby is operated through a Software (SW) which runs on a PC.  
Interaction with the SW is done through a Graphical User Interface 
(GUI) where the various vital signs parameters are changed directly 
or through pre-programmed scenarios. The SW also allows  
automatic and manual logging of scenario events as well as video cap-
ture.  The events logged during a scenario can be shown in a debrief 
viewer together with video capture. The log is synchronized with the 
video capture. This allows the instructor to review both the log and 
actual performance during debriefing. The debrief can also be stored 
for later review.
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Items included

The Laerdal SimBaby includes the following main components:
Laerdal SimBaby Manikin
SimBaby Software CD-ROM
Presentation CD-ROM: Set-up/Features/Configurations
SpO2 Pulse Oximetry Probe
Set of plates for Manual Defibrillation
Airway Lubricant
Esophagus filter assy (50)
Pneumothorax Kit, consisting of:
-	 Extra Pneumothorax Bladder
-	 Extra Pleura Sleeves (10)
-	 Extra Chest Skin
IV/IO Kit, consisting of:
-	 Tubing, arm 
-	 Extra arm skin
-	 Lower IV/IO leg right 
-	 Lower IV/IO leg left 
-	 Simulated Blood Concentrate
-	 Blood system 
Talcum Powder
Blood Pressure Measuring Kit

Additional items required for use: (configurations vary)
-	 Laptop computer 
-	 USB Camera
-	 Simulated Patient Monitor 
-	 USB Hub
-	 Link Box 

Connection Cables and Tubing, consisting of:
-	 Power supply, Simulated Patient Monitor
-	 AC Line Cord, Link Box
-	 Cable, Link Box to Manikin (15-pin)
-	 Cables, PC to Simulated Patient Monitor (signal and USB)
-	 Cable, Link Box to PC (9-pin)
-	 Cable Audio, PC to Link Box and Patient Monitor
-	 Hose, Manikin Air and CO2 Supply

Pressurized Air and CO2 source 
(to be purchased separately if not included): 
-	 Compressor Unit (included in some configurations)
	 or Regulator Unit

Getting started

(See also Presentation CD-ROM included with the SimBaby or 
www.laerdal.com for details regarding connections)

Link Box
The Link Box connects the manikin to the computer. 
To connect:
1)	Attach manikin cable to right lower side of manikin’s torso and  
	 to the connector marked “Manikin” on the back of the Link Box.
2)	Connect serial cable to connector marked “PC” on the back of  
	 the Link Box and to serial port on back of your computer.
3)	Connect clear tubing from blood pressure cuff to the inlet  
	 marked “BP cuff” on the back of the Link Box. 
4)	Connect the SpO2 cable to the SpO2 connector on the back  
	 of the Link Box.
5)	Connect one end of the audio cable to the connector marked  
	 “Audio input” on the back of the Link Box and one to the Patient  
	 Monitor, and the other end with the mini-jack plug into the  
	 headphone outlet of your computer.
6)	Plug the Link Box AC power cable into a power supply  
	 (110-240 V AC).  If you are using the Portability Kit, attach to  
	 the 12 V DC input according to the Portability Kit instructions. 
7)	Connect external speakers, if used, to connector marked “Ext.  
	 speaker” on back of Link Box (external speakers not included).

USB Hub
Connect the USB Hub to one of the USB connectors at the back of 
the PC. Attach the AC adapter to the USB Hub and to a wall outlet 
(110 or 230-240V AC).

USB Camera
The USB Camera provides enhanced debriefing possibilities. Follow 
the installation instructions on the camera packaging. The Camera is 
connected to the PC using a USB connector. Video input is synchro-
nized with the SimBaby application, providing replay combined with 
log. For set-up of the camera, see the installation guide provided 
with the camera.

SpO2 Probe
The SpO2 probe provides enhanced realism for the care provider 
by simulating the use of an actual pulse oximetry probe. When the 
probe cable is connected to the Link Box, SpO2 will not be dis-
played until the probe is placed onto the manikin. If the probe is not 
attached to the Link Box, SpO2 will only be displayed automatically 
when selected by the user through the instructor panel on the PC.

SimBaby DfU EN rev C.indd   4 29.06.2011   15:05:21



EN
G

LI
SH

5

Simulated Patient Monitor
The Simulated Patient Monitor allows any or all of the patients’  
status data (ECG, Heart Rate, Arterial BP waveform, NIBP, 
Temperature, SpO2, CO2, CVP etc.) to be displayed. To con-
nect, attach the monitor cable to the PC’s monitor connector, the 
USB cable to one of the USB connectors or to the USB Hub, and 
the Audio Cable as described earlier under “Link Box”. Plug the 
Simulated Patient Monitor power cable into a power supply  
(110 V or 230-240 V AC). The Patient Monitor has to be calibrated 
the first time of use. See the Install Guide for more information.

Blood system
The blood system includes a blood bag and three tubes with valves 
that can be connected to the veins in the arm and both legs. The 
“blood pressure” in the system can be altered by moving the blood 
bag up or down.

Air and CO2 Source (optional)

Option 1: Compressor Unit

If you have purchased Laerdal SimBaby with a Compressor Unit, 
attach one end of the double lumen hose into the compressor and 
the other to the hose that comes out of the manikin.  

Start procedure:
1.	Check that Power switch (4) is set to off position “0”.
2.	Plug power supply cable into plug (5) in Compressor panel.
3.	Plug power supply cable into power source.
4.	Connect CO2 supply to the “Input CO2” connector using  
	 the black hosing attached (optional feature).
5.	Check that Drain valve (1) is closed.
6.	Close Air valve (2) and CO2 valve (3).
7.	Push Power switch (4) to on position “1”, the Compressor will  
	 start and run for approx. 45 seconds to build up pressure in tank.
8.	When Compressor stops, you can start to use the manikin.  
	 Open the Air valve (2) and the CO2 valve (3). 
9.	The Compressor will start and stop with different intervals 
	 depending on consumption of air.    

Stop procedure:
1.	Push Power switch (4) to off position “0”, the Compressor  
	 will stop if it is running.
2.	Close Air valve (2) and CO2 valve (3).
3.	Open Drain valve (1) and drain air out of system.

Warning:
Do not open Compressor box when energized, dangerous voltage 
inside. To be opened by authorized personnel only. 

Important:
If the Compressor Unit is stopped manually with the on/off switch,  
the air tank has to be drained before restart. 

Option 2: Regulator Unit

If you have purchased Laerdal SimBaby with the Regulator Unit, 
attach one end of the double lumen hose to the “Air/CO2, out to 
Manikin” outlet on the regulator and the other to the hose that 
comes out of the manikin. 

 Start procedure:
1.	Close Air valve (Shut off Air) and CO2 valve (Shut off CO2).
2.	Connect Air supply (5-8 bar) to the “Air in” connector using  
	 the blue hosing attached.
3.	Connect CO2 supply (4-6 bar) to the “CO2 in” connector using  
	 the black hosing attached (optional feature). 
4.	Open Air valve (Shut off Air) and CO2 valve (Shut off CO2). 

Stop procedure:
Close Air valve (Shut off Air) and CO2 valve (Shut off CO2).

Important:
Never leave the manikin with pressurised air present in the hose 
as this may ruin some of the manikins functions.
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Operating software
The SimBaby Software serves as the instructor’s tool for controlling 
the training scenario. It requires the following: 
-	 Type Dell Latitude D600 or similar
-	 Processor: 	 Intel Core i3
-	 Hard drive: 	 60 GB minimum
-	 RAM: 		  2GB
-	 System: 	 Windows XP Pro
-	 Screen: 	 Dual Screen 1600x900 / 1280x1024 resolution
-	 Mouse: 	 Two (2) button scroll wheel mouse
-	 Other: 		 CD-RW, RS-232 (serial port), 2-4 USB ports,  
			   Internal Bluetooth, Microphone input, 		
			   Headphone output

For software installation, see instructions included in the Install 
Guide. The software features are:
a) Training controls via computer keyboard, mouse and/or PDA 
b) Variable extrasystole rate and choice of various extrasystole types
c) Variable pacemaker threshold (external pacemaker training only)
d) Control of manikin functions
	 - Airway complications
	 - Tension Pneumothorax
	 - Breathing
	 - BP - NIBP and Arterial
	 - SpO2 simulation
	 - Fontanell 
	 - Temperature display
e) Auscultation sounds 
	 - Lung
	 - Heart
	 - Bowel
f) Vocal sounds 
	 - Numerous vocal sounds are available (crying, hicup, etc.)
	 - Additional sounds can be recorded by the user 
	 - Microphone option (instructor may speak directly through  
	   the manikin’s head speaker by using a microphone)
g)	Left/right or bilateral lung obstruction
h)	Pulse strength
i)	 Activity Log
j)	 Scenario Builder
k)	Trend Editor
l)	 Event Handler
m)Debriefing including activity log synchronized with video  
	  and monitor pictures

Simulated Patient Monitor
The Simulated Patient Monitor is connected to the PC (laptop).  
It is a touch screen monitor that provides concise clinical feedback 
of physiological parameters. All parameters are instructor-activated 
with the ability to set a lower and higher alarm limit for every  
parameter shown on the monitor. The monitor may be configured 
to display the desired parameters and curves and it is possible to 
save and retrieve five (5) configurations. Colors and curve trace 
speeds can also be changed. The CO2 curve has by default a slower 
trace speed. Because all information is simulated rather than actual, 
the parameters, with the exception of ECG, cannot be “measured 
or displayed” on clinical equipment.  For additional information, refer 
to the software helpfiles. 
The monitor provides the following output (synchronized with all 
other clinical outputs)
-	 Arterial blood pressure waveform
-	 CO2 and capnograph waveform
-	 Heart rate related to SpO2

-	 BP – with timed automatic updating and ‘BP now’ function
-	 Respiratory rate 
-	 SpO2 waveform and numerical display with audio output
-	 CVP waveform and numerical display output
-	 PAP and Wedge
-	 TOF
-	 TOF%
-	 CO
-	 FIO2

-	 FIN2O
-	 FI Anesthetic agent
-	 ETO2

-	 ET Anesthetic agent
-	 Core temperature
-	 Peripheral temperature
-	 Monitor trends
-	 12-lead ECG with adjustable ST-elevation and conduction  
	 on some rhythms
-	 X-ray
- 	ICP

Calibrating the Patient Monitor
Because the Simulated Patient Monitor uses touch-screen  
technology, it must be calibrated before use. To calibrate the moni-
tor:
-	 Click the triangle symbol in the lower right corner indicated in 	

the picture.
-	 Double click on the ELO logo. (If you cannot find it in the 

system tray, activate Elo Touchscreen in the Control Panel.)
-	 Click on the Align button on the dialog that appears.
-	 If target indicator first appear on the computer screen, press Esc, 	

or wait until it appears on the Patient Monitor.
-    	When the target appears on the Patient Monitor, touch each 	
		 target as it changes position, and finally touch the green tic 
		 button.

USB Camera
The USB Camera provides enhanced debriefing possibilities. Video 
input is synchronized with the SimBaby scenario log. To set-up the 
camera, see Install Guide and Directions for Use included in your 
camera packaging. 

Important: 
Connect the camera via a USB port directly on the laptop.  
Do not use the hub as this may cause interference.
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In Use

Head
The infant head offers realism by including an anatomical correct 
cervical neck that offers a realistic range of flexibility.  
The head allows for performance of head tilt and jaw thrust maneu-
vers. Bulging fontanel can also be simulated. The eyes have inter-
changeable pupils for simulation of three different pupil sizes 
- contracted, normal and dilated.

Airway and Lungs/Stomach
a)	Airway anatomy:
	 The infant manikin provides an anatomical realistic upper airway  
	 including:
	 -	 Oropharynx
	 -	 Nasopharynx
	 -	 Laryngopharynx
	 -	 Carina
	 -	 Trachea
b) The manikin simulates spontaneous respiration with the following 	
	 features: 
	 -	 Chest rise and fall
	 -	 The variable respiratory rate is synchronized to the Simulated  
		  Patient Monitor display and lung sounds
	 -	 The tidal volumes dynamically alter in line with the selected 
		  respiratory rate
c)	SimBaby accepts a wide range of airway management devices  
	 and techniques. Some examples are:
	 -	 Bag-Valve-Mask (BVM)
	 -	 Oral/nasal pharyngeal airways 
	 -	 Endotracheal tubes - nasal and oral [recommended ET tube  
		  size is 3.5. We also recommend the use of a malleable  
		  stylette. Care should be taken, that the stylette does not  
		  extend beyond the end of the tube, as with any direct  
		  intubation.]
	 -	 Laryngeal Mask Airways (LMA) [The Laerdal SimBaby will  
		  allow use of the LMA Classic and LMA Unique.  
		  Recommended size is 1.5.]
	 -	 Fiberoptic procedures
	 -	 Nasogastric tube insertion
	 -	 Correct form and technique are required to perform direct  
		  laryngoscopy and Endotracheal intubation
	 -	 Correct use of a variety of airway adjuncts will successfully 
		  ventilate the patient simulator
d) The manikin contains two lungs. Too deep intubation will result  
	 in unilateral lung filling. This usually occurs on the right side, due  
	 to the accurate anatomical modeling of the tracheobronchial  
	 junction. 
e)	The system does not accept PEEP modes of ventilation.
f)	Mouth-to-mouth/nose/mask ventilation shall not be performed  
	 on SimBaby due to cleaning issues. 
g)	The airway contains a number of instructor-controlled airway  
	 complications.  
	 Using the computer user interface, the following  
	 airway functions can be activated and deactivated:
	 -	 Pharyngeal Obstruction
	 -	 Tongue Edema
	 -	 Laryngospasm
	 -	 Decreased Lung Compliance
	 -	 Increased right and/or left lung resistance
	 -	 Pneumothorax
	 -	 Stomach Decompression
	 -	 Exhale CO2

	 -	 Variable breathing rate

	 -	 Variable breathing pattern
	 	 • See-saw breathing
	 	 • Subcostal retractions
	 	 • Unilateral breathing
	 -	 Apnea
	 -	 Variable pulse oximetry display
	 -	 Breath sounds

Important: 
Prior to using airway adjuncts, spray all airway management devices to 
be inserted with a small amount of the provided airway lubricant. Use 
only a very liberal amount of airway lubricant in the manikin’s airway.
Make sure to replace the Esophagus filter after every session/course if 
airway lubricant has been used.

Torso
a)	Anatomically modeled from live babies, the torso demonstrates 
	 normal anatomical surface landmarks.
b)	SimBaby has correct anatomical landmarks for external chest 
	 compressions. Chest compressions will produce compression 
	 artifacts on the Simulated Patient Monitor and palpable pulse.

c)	Manikin is equipped with separate defibrillation and ECG 
	 monitoring connectors. The system provides real 3-lead ECG 
	 readings (4 connectors).

Note: The ECG connectors are designed for ECG monitoring only.  
If defibrillation is attempted over any of the ECG connectors, high  
voltages may be present on one or more of the uncovered connec-
tors during the shock. (See the “Cautions and Warnings” section.) 
Defibrillation attempts via the ECG connectors will also damage the 
internal electronics requiring that they have to be replaced.

d)	Manikin is equipped with two defibrillation connectors. ECG  
	 signal can also be monitored across these connectors. Instructor  
	 can select, via appropriate keyboard command, the “Ignore  
	 Defib” function. This determines if the defibrillation shock results  
	 in conversion to a selected waiting rhythm. Manual paddle  
	 adapters (Manual Defib. Plates) are supplied for use with  
	 manual defibrillators.

Note: Defibrillation must be performed only over the two defibrillation 
connectors. (See the “Cautions and Warnings” section.)
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Cautions and warnings

-	 There are electronic components mounted inside the 
simulator’s airway management head. The following techniques 
should not be performed on this simulator due to the inability to 
properly sanitize the airway if they are performed: 
	 1. Mouth-to-mouth/Mouth-to-mask ventilation
	 2. Insertion of simulated vomit for suctioning 
-	 Lubricate the oral and nasal airways liberally with the lubricant 
provided prior to inserting any instrument or tube into the airway. 
Additionally, instruments and tubes should also be lubricated prior 
to use.
-	 Do not allow the manikin’s skin to come in direct contact with 
ink or photocopied paper, as this can permanently stain the skin. 
Avoid using colored plastic gloves when handling the manikin, as 
they may also cause discoloration.
-	 Care should be taken when palpating the pulses to not use 
excessive force as this will result in no pulse being felt. Only two 
individual pulses can be felt at the same time.
-	 When the Resusci Anne Simulator is in the “Off” status the air-
way will remain open. If the simulator is turned off while the closure 
valve is in the closed position it will open automatically when the 
simulator is turned off.
-	 To avoid damaging the spontaneous breathing bladder, do not 
perform chest compressions while the spontaneous breathing func-
tion is activated.
-	 If a training session involves the administration of fluids and/or 
drugs into the IV arm, empty the arm immediately following the trai-
ning session.

	 Defibrillation
	 -	 Only apply the defibrillator to a defibrillation chest skin 
which  
	 is properly mounted on the manikin’s chest. 
-	 Do not provide more than 2 x 360J defibrillator discharges  
	 per minute as an average over a period of time to prevent  
	 overheating. 
-	 The manikin chest must be kept dry. Special attention should  
	 be taken when using IV Arm. 
-	 Do not apply conductive gel or conductive defibrillation pads  
	 intended for patient use to prevent chest skin pitting. 
-	 Do not use cables or connectors with visible damage. 
-	 Observe all normal safety precautions for use of defibrillators. 
-	 Defibrillation must be performed over the two defibrillation  
	 connectors only. 
-	 Electromagnetic radiation from other radio transmitters or  
	 other electronic equipment may cause noise in the head  
	 speaker. To eliminate this noise move manikin away from  
	 the radiation source or turn the head speaker volume to zero.

e)	Connectors for external pacing are connected to the manikin’s 
	 defibrillation connectors. Patient pads should not be used, as they 
	 do not guarantee sufficient contact. The system has a variable 
	 pacing threshold and the ability to “ignore” pacing. Pacing capture 
	 results in a pulse synchronized with the heart rate and the display 
	 of a paced rhythm on the Simulated Patient Monitor.

Pneumothorax
Pneumothorax on left side can be simulated through the software. 
The students will then see unilateral chest rise on the manikin.

a)	Chest Drain / Chest Tube
	 Chest Tube insertion can be performed at the left mid-axillary  
	 site. A cut can be made at left mid-axillary line at the (4th and)  
	 5th intercostal space.
 
b)	Needle Decompression 
	 Needle decompression can be performed at the left  
	 mid-clavicular line, 2nd intercostal space. We recommend a  
	 22-gauge needle for decompression of the chest. Using a smaller  
	 gauge needle increases the longevity of the chest skin and bladder.

Sounds
The torso contains a number of hidden speakers that allow the  
realistic auscultation of sounds:
-	 Lung, left and right
-	 Heart, upper and lower

Abdominal distension
Abdominal distension occurs with too high ventilation pressure 
while using Bag-Valve-Mask. NG Tube can be inserted. Operator 
needs to activate gastric distension through the software to release 
the air from the stomach.

Body movement
Body movement can be simulated and requires that the manikin 
lie onto a rigid base. Place a piece of cardboard or equal under the 
manikin if the manikin is placed on a soft surface (bed, mattress etc.).

Pulses
a)	SimBaby has palpable pulses:
	 -	 Bilateral femoral pulse
	 -	 Left radial and brachial pulse 
b)	The pulses are synchronized to the simulated ECG and, 
	 when activated, the external pacemaker upon capture.
c)	Pulses, once activated, will remain on for approximately five 
	 (5) seconds before reactivation is required.

Note: Care should be taken when palpating pulses. Use of excessive 
force results the inability to feel pulse.

Arms
a)	Blood Pressure Arm
Left Arm is a Blood Pressure Arm with radial and brachial pulses 
and Korotkoff sounds. Blood pressure can be measured using the 
supplied blood pressure cuff attached to the link box and installed 
onto the left arm (BP Arm) brachial position.
Blood pressure settings are controlled using the computer, and  
linked to the ECG functionality, so if you are changing the rhythm 
from a perfusing rhythm to a non-perfusing rhythm, this will also 
be reflected on the blood pressure settings, which will be changed 
according to the new type of rhythm. A non-perfusing rhythm will 
change breathing rate (BR) to zero. When changing to a perfusing 
rhythm, the blood pressure will remain at 0/0 until changed; 

breathing rate cannot be changed until blood pressure 
has been established.
Auscultation gap can also be simulated.

b)	IV Arm
Right Arm is dedicated to IV skills and allows:
-	 Cannulation
-	 Phlebotomy
-	 Drug administration
-	 Infusion
The veins are self-sealing allowing multiple uses; however, repetitive 
insertions in the same area will result in leakage sooner than if the 
cannulations had been spread over a wider area. Using smaller size 
needles will also extend the “life-time” of the veins. The venous sys-
tem and the skin sleeve are both replaceable.
The IV arm can be used with simulated blood by attaching one of 
the supplied blood system tubes to one of the two latex vein ope-
nings near the top of the arm. Using the supplied simulated blood 
concentrate, mix the desired volume of simulated blood and add to 
the IV bag (see procedure below). Release simulated blood until it 
runs via the tubing into the arm and out the other latex vein. Once 
fluid is running freely out of the second vein, seal it using a clamp. 
Using a 22 gauge (or smaller) needle for IV training increases the 
life of the IV arm skin. If you want the student to infuse medicines, 
attach a second IV bag for free flow.

Legs
Both legs have IO and IV access with replaceable lower legs that 
include the IO and IV access points. The IV/IO legs can be used with 
simulated blood. Using the supplied simulated blood concentrate, 
mix the desired volume of simulated blood with water and add 
to the IV bag (see procedure below). Before IV/IO practice can 
start, fill the lower legs with simulated blood. Use a syringe and fill 
the lower legs through the drain plugs at the back of the lower leg 
(drain plug to be the highest point to avoid air remaining in the leg). 
Attach two of the supplied blood system tubes to the latex veins 
openings near the top of the lower legs and release simulated blood 
until it runs via the tubing into the legs (make sure the drain plugs 
are not closed before this procedure is done). Close drain plug 
when fluid is running freely. Using a 22 gauge (or smaller) needle for 
IV training increases the life of the IV leg skin and vein. For IO trai-
ning a 14 gauge (or smaller) needle is recommended. Replace the 
lower leg after each course if used for IO cannulations.

Procedure for filling Blood Bag (IV Bag)
Use a syringe to inject fluid into IV bags, and fill to desired level.
Control flow of blood into arm and legs, via valves.
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Air and CO2 Source
Compressed air is provided by a compressor or other type of  
pressurized air source via a regulator unit, allowing many functions 
to take place:
-	 Airway complications
-	 Spontaneous breathing
-	 Tension pneumothorax inflation
-	 Carotid pulse

The compressor unit operates at 110 or 230 – 240 V AC. It can be 
connected to a CO2 source for exhaled CO2 to take place.

Starting the software
The SimBaby SW is started by clicking the SimBaby icon on the  
computer desktop. After entry of password (optional) and  
selecting a profile, the SimBaby starts up in the default mode  
which represents a patient in a healthy state.  If the web camera  
recording is enabled, you will be prompted to start the recording.  
For more information on this feature, refer to the section on  
video recording later in this document or to the help files. 

Operating software
The operating software is controlled via a Graphical User Interface 
(GUI). The GUI displays an overview of the current status of simu-
lated patient’s vital signs,  the control functions for modifying these, 
and a time-based log of the events which has occurred during the 
scenario.

The patient simulator can be operated in three manners; 
-	 Manual mode,
-	 Semi-automatic mode 
-	 Automatic mode

Manual mode
In manual mode  the vital signs parameters are changed  
directly through changing the values one-by-one based on the  
desired change of the patient condition.
The various vital signs parameter can be changed directly on the 
GUI in the following ways. For detailed description, please see help 
files under “Help” in GUI’s Program Menu Bar.
-	 To change values in the  “Instructor Monitor Control Center”  
	 (upper right corner of the GUI); click on the parameter and set  
	 the new values, or  rotate the mouse wheel while the cursor is  
	 over the numerical values.
-	 To change values in the  “Airway and Circulatory Control  
	 Centre” (center section which includes a torso illustration), by  
	 click directly on the parameter which is to be changed and select 
	 the new state, or use the slider bars.
-	 To change values in the  “Respiratory Control Center” and  
	 “Difficult Airway Control Center” (upper left corner) by select  
	 state or use the slider bars.

Semi-automatic / Automatic mode 
In semi automatic / Automatic mode the change to multiple vital 
signs parameter can be pre-defined as “trends”. These trends can 
then be activated one by one directly or multiple activated via  
the “event handler” function. Trends allow the instructor to  
introduce physiologic situations into the simulation. A brief overview 
is shown below, for more information refer to the help files. 

To use pre-programmed or saved trends:
1.	select the “Start/Stop…” button located in the Trends box  
	 in the main window
2.	select the desired trend
3.	click the start button.

To build and save new trends:
1.	select “Start Trend Editor” from the Edit dropdown menu
2.	select the parameter to be included in the physiologic model  
	 of the trend you wish to design
3.	click “ok”

Automatic mode, creating and using scenarios
In automatic mode, scenarios which includes multiple  
alternative and consecutive changes to the vital signs can be  
pre-defined. The scenarios can be constructed so that the change 
from one condition to the next may have multiple outcomes.  
The various outcome alternatives has been defined in the scenario 
and triggered by pre-defined events. These events may be either 
automatically registered events such as “time” or a defibrillator 
shock, or by manually entered events such as administration of 
drugs.
 
SimBaby is delivered with a set of pre-programmed scenarios.  
Pre-programmed or saved scenarios can be started, paused, halted 
or debriefed from the “Scenario Control Centre” found in the  
lower left quadrant of the GUI. 

To start a scenario:
1. click “Start Scenario” 
2. select a simulation case to run

To temporarily halt the scenario, click on the pause (II) symbol.

To resume a simulation that has been paused, click on the play (   ) 
symbol.

To halt a scenario, click on the halt (    ) symbol.

Before creating a new scenario, it is important to understand the  
difference between Events and Actions.

Events
Things that happen outside of a scenario, usually caused by students, 
are called “Events.” The ABC/Miscellaneous/Medication events in 
the main window are also called “Scenario Events.” There are also 
“Time Events” caused by either of the two timers reaching a  
predetermined limit

Actions
In a scenario, “Actions”  are performed by the scenario.  
For example, changing a parameter value, creating an airway  
complication and making vocal sounds are “Actions” performed  
by scenarios. 

To create a new scenario:
1.	Choose “Start Scenario Editor” from the Edit dropdown  
	 menu then
2.	click the new scenario (ù) button
The scenario is constructed from a set of frames. Each frame repre-
sents a state of the patient. The scenario can only operate in a single 
frame at any given time. The scenario moves to other frames as 
events specified in the “Events field” occur. To control which frame 
the scenario moves to, connection lines are drawn from each event 
box to the desired frame. When the specified event occurs, the 
scenario moves to the corresponding frame. For a more detailed 
description, refer to the software help files. 
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Saving Scenarios
To save a new scenario:
1. Select “File” from the dropdown menu 
2. Enter the name of the scenario
3. Click the “Save” button.

To retrieve the file at a later time:
1. Click the “Start Scenario” button on the GUI 
2. Select your saved scenario

Debriefing during or after a scenario
The debriefing function is available both during and after scenarios. 
To activate the debrief view, click on the “Debrief” button. If you 
are currently running a scenario, this action will automatically pause 
your running scenario and take you to the debrief screen. After you 
have reviewed the log, you can choose to save the debrief or return 
to the scenario without saving. To exit, select “Exit” from the file 
dropdown menu and follow the prompts to save or exit without 
saving as desired. If you paused a running scenario,  click on the play 
(   ) button from the main SimBaby GUI to resume the simulation. 
For more information on the Debrief viewer, refer to the help files.

Halting the scenario
When a scenario is running, clicking the  halt  (    ) symbol will 
put the scenario in manual mode. The software will confirm that 
you want to stop the scenario. After a “yes” response the word 
“Halted” will appear on the screen. The scenario continues to run 
but all operations must be carried out manually by the instructor. 
To fully stop and save a scenario, click the debrief button. When the 
debrief viewer appears, choose “Save As” from the “File” dropdown 
menu. 

Instructor Monitor Control Centre
The instructor can manipulate the values of the monitor parameters 
from the Instructor Monitor Control Centre which can be found 
in the upper right quadrant of the main GUI.  Adjustments can 
be made to any of the physiologic values by pointing the mouse 
over the desired area and clicking. Windows will open allowing the 
instructor to select and apply the desired changes and functions.

Configuring the Patient Monitor and Simulator and 
Creating Profiles
General configurations for both the simulator manikin and patient 
monitor can be controlled via the GUI. To configure:
1.	Select “Configure” from the “Edit” dropdown menu
2.	Select either the “General” or “Patient Monitor” tab.
3.	Double click on the appropriate icon to enter submenus.
4.	Make desired changes
5.	Select “ok” to initiate the change.
If you have changed the configuration, the software  will ask you 
whether or not you wish to save the changed configuration, try it 
without saving or cancel the operation. If you choose “yes,” you will 
be asked to name the new profile you created. A space is provided 
for additional comments. To open a saved profile, follow the steps 
shown above to open the configuration window then select “Open 
profile.”

Edit the Patient Monitor Set-Up from the GUI
The patient monitor can be edited to replicate different healthcare 
institutes and clinical environments thus increasing realism during 
scenarios. To access the patient monitor set-up:
1.	Open the “Edit” dropdown menu
2.	Select “Edit Monitor Set-up…”

A window will open showing the standard patient monitor configu-
rations. Refer to the help files for a detailed description of the dif-
ferent configurations. 

Choose Monitor Set-Up Using View
The patient and the instructor monitor can be individually  
configured. Click on “View” to show the dropdown menu.  
The default settings shows “Instructor = Monitor” checked,  
indicating both displays are the same. If different settings are requi-
red, uncheck “Instructor Monitor - Patient Monitor”  

To select the desired monitor configuration:
1.	Click  “view”
2.	Select “Patient Monitor Setup…” or “Instructor’s Monitor Set-up” 
	 from the view dropdown menu.
3.	Select the desired monitor configuration and click “open”  
	 to activate the new configuration.

Video recordings
SimBaby  utilizes a webcam for recording the students’ performance 
during a scenario. For a complete debriefing experience, the recor-
dings can be integrated into the debriefing guide.

To set-up the camera for video recording, follow the instructions 
provided in the “Install Guide.” Be sure to note that the camera 
should be connected directly to a USB port on the back of the lap-
top. Do not use the hub as this may cause interference. Select the 
“Video Recording Configuration” from the “Edit” dropdown menu 
then make your selections and press “ok”.

Note: Video will be stored on the hard drive of the instructor’s computer. 

SimBaby DfU EN rev C.indd   10 29.06.2011   15:05:22



EN
G

LI
SH

11

After use

-	 Be sure that compressed air is not present in the manikin  
	 when training session is over.
-	 Clean manikin skin with mild soap and water. Make sure that  
	 no water comes inside the manikin. Do not submerge manikin.
-	 Clothes can be hand or machine washed with soap or laundry  
	 detergent in warm water, max. 60oC (140oF). Iron with warm  
	 iron. May be dry cleaned. Please note that hot air dryer may  
	 cause garment shrinkage.
-	 Modules and all other parts shall be drained, flushed through with  
	 water and air-dried thoroughly prior to storage.  
	 Disinfectants should be used when appropriate.
-	 Replace Esophagus Filter assy after each session  
	 (see Maintenance section for details).
-	 Replace lower legs if IV/IO skills have been practiced.
-	 Store properly between teaching sessions. If stored in hard  
	 cases disconnect cables and tubings. 
-	 Air filter in compressor should be replaced every two years.  
	 Directions for replacement are part of the Technical/Service  
	 manual.

Maintenance

Tension Pneumothorax Decompression–left Mid-Clavicular site
To replace bladder:

1)	Remove skin at torso sides and loose inside tap at the umbilical 
	 area from its seat.
2)	Lift the chest plate assy exposing its underside.

3)	Disconnect bladder hose from the nipple.

4)	Remove bladder from site cavity by sliding it sideways out 
	 of the chest.

5)	 Insert new pneumo bladder into site cavity and reconnect  
	 to the nipple.
6)	Replace chest plate assy.
7)	Replace chest skin over torso, fasten the tap inside the skin 
	 to its seat and secure skin at the shoulders and both sides.

Chest Drain - Left Mid-Axillary Site
To replace pleura sleeve:
1) 	Loose chest skin at left side or remove chest skin 
	 (see procedure above).

2)	Remove chest tube insertion module from mid-axillary 
	 side of manikin.

3)	Replace the pleura (foil) sleeve.
4)	Put chest tube insertion module back into the torso.
5)	Secure chest skin or replace with a new skin  
	 (see procedure above).
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IV Arm
When excessive leaking occurs at the puncture sites, a new vein and 
skin should be installed to reduce loss of fluid. 

To replace the vein:

1)	Pull the skin and vein off the arm. While doing this make 
sure 	
	 you hold the manikin’s shoulder (not the torso) with your  
	 other hand. 

2)	Route a new vein along the groove in the arm, leaving the two 
	 ends of approximately equal lengths. Support the vein so it does 
	 not fall out of the groove while you pull on a new arm skin.

3)	Slide a new arm skin over the arm and vein. Make sure that the 
	 two holes line up with the ends of the groove close to the 
	 shoulder. Use of talcum powder may ease this procedure.

4)	Pull the open ends of the vein through the holes in the arm skin.

Esophagus filter assy
After each session/course the esophagus filter assy shall be replaced 
by a new one.
1)	Remove chest skin (see procedure above).

2)	Lift the chest plate assy exposing the internal parts  
	 and find the filter holder (see figure).

3)	Disconnect the filter assy and replace by a new one.
4)	Replace chest plate assy and chest skin (see procedure above).

Pupils
There are three extra sets of eyes included with the manikin; normal 
(default with the manikin), contracted and dilated.. 

If you want to add some of the attached pupils to the manikin, open 
up the eyelids with your fingers, remove the installed pupil from its 
seat using the eye lens replacement device included and install the 
desired pupil into its seat using the same tool.
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IV/IO Leg
When excessive leaking occurs at the IV/IO puncture sites, 
the lower leg should be replaced by a new one.

To replace lower leg:

1)	Press the bolt in the knee part out of its seat.

2)	Replace the lower leg by a new one.

3)	Secure the leg by pressing the bolt into its seat.

Trouble shooting

If your system does not work check that set up is correct according 
to “Getting started” section.

Technical data

Power consumption:
Link box and manikin	 Input 110/230V AC	 1.4A
	 Output 12V DC	 5.0A

Patient Monitor 
(power supply)	 Input 100-240V AC	 50W

Compressor unit	 Input 110V AC	 1.9A
	 Input 230V AC	 1.0A

Air consumption:
Compressor air outlet	 1.1 bar +/- 10%
Compressor CO2 outlet	 0.7 bar +/- 15%

Weight and size:
SimBaby manikin	 4kg (8.8 lbs)	 65x23x16cm
Compressor	 14kg (30.8 lbs)	 35x43x24cm
Regulator unit	 1.5kg (3.3 lbs)	 20x16x11cm
Patient monitor	 9.6kg (21.1 lbs)	 44x44x24cm
Link box	 2.4kg (5.3 lbs)	 21x10x22cm

Environmental condition:
Operating temperature	 +10C to +40C
Storage temperature	 -15C to +50C
Humidity	 15 to 90% RH (non-condensing)
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Parts / Accessories List

Accessories
1005146	 Tubing Assy 40ft Compressor-Manikin, Air /
CO2	
1005164	 Cable Assy 25ft, Manikin-Link Box (15-pin 
D-sub)	
210-01050	 Compressor 230 V	
210-01150	 Compressor 110V	
381220	 Regulator Unit for Fixed Air Supply	
381850	 Portability Kit	
245-19550	 Technical/Service Manual	
245-18050	 Transportation case (for patient monitor etc.)

Consumables
100019	 Blood Concentrate, 100ml	
250–21050	 Airway lubricant, 45ml (glycerol version)	
245-12150	 Skin & Vein, IV Arm	
245-13250	 Pneumothorax Bladder (pkg.5)	
245-13150	 Pleura for Chest Tube Module (pkg.10)	
245-11650	 IO/IV leg lower left (pkg.3)	
245-11150	 IO/IV leg lower right (pkg.3)	
245-16850	 Esophagus filter assy (pkg.50)	
254-11350	 Blood system	

Spare Parts
260305	 Power-cord (US)	
260306	 Power-cord (EUR)	
260307	 Power-cord (UK)	
271500	 Cable 9-pin D-sub (PC to Link Box)	
245-16350	 Cable 15-pin D-sub (Link Box to Manikin)	
380100	 Link box	
245-12550	 Arm Assy, Blood Pressure	
245-12650	 Cuff Assy, Blood Pressure	
380410	 Defib studs set	
245-13050	 Chest Skin 	
245-12050	 IV Arm, right	
381010	 Tubing Assy, Compressor-Manikin, Air /CO2	
245-10050	 Head Assy 	
245-10150	 Head Skin 	
245-16750	 Audio Cable	
245-11250	 SpO2 Pulse Oximetry Probe
245-19050	 Directions for Use	
245-10250	 Eyes set	
245-98050	 USB Hub	
245-96050	 USB Camera	
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